Worksheet
1. Networking
A. Fill in the blanks.
1.
2.
3.
4.
5.

When a number of computers are interconnected, it is called a _________________.
Each computer in a network is called a __________.
Networking started evolving in _______ by the development of the first network _________.
_________ is a device which divides a network into different subnetworks called ___________.
___________________ is a connection created for an individual person.

B. State whether the following statements are True or False.
1.
2.
3.
4.
5.

Networking helps to share the resources in communication.
A network card is also called LAN card or Ethernet card.
Computers network that spreads over a localised area like an office is known as WAN.
Wi-Fi refers to wired fidelity.
Computers which request services like data retrieval and storage from the server are called
servers.

C. Match the columns.
		

Column A		

1. Star Topology

(a)

2. Bus Topology

(b)

3. Ring Topology

(c)

4. Tree Topology

(d)

5. Mesh Topology

(e)

Column B

D. Explain the following.
1. Client-Server Network

2.

Peer-to-Peer Network

3. Ring Topology

4.

Point-to-Point Topology

5. Network Interface Unit
E.

Answer the following questions.
1. What are the various types of wired networks?
2. What are various kinds of wireless networks?
3. What is network topology? Name the different types of network topologies.
4. Write a note on network architecture.
5. Write a note on network security.

Answers to Worksheet
A. 1.
2.
3.
4.
5.
B. 1.
C. 1.
D. 1.

2.

3.

4.

5.

E. 1.

computer network
node
1960, ARPANET
Switch, subjects
Private Area Network
True
2. True
3. False
4. False
5. False
(e)
2. (a)
3. (b)
4. (c)
5. (d)
In client-server network, several computers called clients or nodes or workstations are
connected to the main computer called the server. A computer that provides services to
control access to hardware, software, and other sources is called server. The computers which
request services like data retrieval and storage from the server are called clients.
A network where a few computers having equal capacity and capabilities are connected
together to use the resources available on the network is called peer-to-peer network. In this
network, there is no central server and each computer can act as a server as well as a client.
Each node in a ring topology is connected to two and only two nodes. This is also called
circular topology. Data transmitted from one of the nodes is passed to other node. Therefore,
the data travels in one direction only from node to node around a ring. The advantage of this
topology is that it is small. This means that less connections will be needed, which will in turn
increase network reliability. However, as transmission of data on a ring goes through every
connected node, if any node fails to pass through data itself, the entire network will fail and
the detection of the faulty node will become difficult.
Point-to-point topology is a network of only two computers where one is the transmitter
and the other is the receiver. It is also called PtoP network. The main feature of PtoP network
is that each station or receiver receives data from one transmitter only and each transmitter
transmits to exactly one receiver.
A stand-alone computer that is not attached to a network cannot share any data. To connect
it to a network and convert it into a workstation or node, a Network Interface Unit is required.
Network Interface Unit is a device that is connected to a server and helps the workstation to
establish network connections.
Following are the various types of wired networks.

• Local Area Network (LAN): Computers network that spreads over a localised area like
an office, a building or a school is known as Local Area Network (LAN). All hardware
and software resources are shared over LAN. Speed of data transfer is slow in a LAN as
compared to other networks.

• Metropolitan Area Network (MAN): It spreads over a city. For example, cable TV network
that spreads over a city can be considered as MAN.

• Wide Area Network (WAN): Network which spreads over countries is called Wide Area

Network (WAN). WAN is a group of computers which can be separated by large distances
and still tied together. It can even be a group of LANs that spread across several locations
and are connected together like a big LAN.

• Private Area Network (PAN): It is a connection created for an individual person. It may be

in the range of less than 10 metres. You can also create a PAN at your home connected to
your laptop, mobile and printer.
2. Following are the various types of wireless networks.

• Wi-Fi: It refers to wireless fidelity, which lets you connect to the Internet without a direct

line from your PC to the Internet Service Provider (ISP). We can use a laptop, Wi-Fi phone or
other suitable portable device to access Internet through Wi-Fi.

• Bluetooth: It is a wireless technology where devices can exchange data over a short

distance. It has become a standard technology nowadays which is found in most of the
devices like smartphones, laptops, portable speakers, headsets and more.

• Step 3: Add all the products to get the decimal number.
3. The physical arrangement of nodes in a network is called topology. The arrangement of
hardware may be physical while flow of information within a network may be logical.
		 Different types of networking topologies are as follows.

•
•
•
•
•
•

Point-to-Point Topology
Star Topology
Bus Topology
Ring Topology
Tree Topology

Mesh Topology
4. An overall design of a computer network that describes the configuration of a network
and various strategies being used in the process is called network architecture. Computer
networks mainly are of two types: Client-Server Network and Peer-to-Peer Network.
Network Architecture

Client-Server Network

Peer-to-Peer Network

5. Network security refers to protecting data and resources from any unauthorised access. It
is the most important aspect in computer networking. Since many users are accessing the
same data, so we must ensure its proper security. Only authorised persons can access or
modify data. There are two general levels of network security.

• Login Security: The user is given a unique login name and password.
• Rights Security: Based upon the user name, the user is given rights, like Read-Only Access

or Read-Write Access or No Access at all. A combination of rights can also be granted to the
same user for different sets of data.

2. Windows Movie Maker
A. Fill in the blanks.
1. ___________________ is a video editing tool provided freely by Microsoft.
2. A movie is created using the images and video files once they are ____________.
3. ______________ shows the transition and visual effects which are applied to the steps to
make videos.
4. A _______________ adds visual effects to the movie.
5. To add text-based information to the movie, _________ and __________ are used.
B. State whether the following statements are True or False.
1.
2.
3.
4.
5.

Windows Movie Maker was earlier known as Windows Live Movie Maker in Windows 7.
Credits are added at the starting of the movie and titles are added at the end of the movie.
Overlay means to emphasise certain effects in a movie.
You can add elements to your movie.
Preview pane is located at the bottom of the screen.

C. Match the columns.
		
1.
2.
3.
4.
5.

Column A		
Menu Bar
(a)
Tabs
(b)
Quick Access Bar
(c)
Preview Pane
(d)
Storyboard
(e)

Column B
Import Files, Import Folder and Add to Timeline
On the left side of the screen
Used to navigate through clips
File, Export, Help and Register
Located on the middle screen

D. Label the different components of Windows Movie Maker.

E.

Answer the following questions.
1.
2.
3.
4.
5.

Write the features of Windows Movie Maker.
Write the steps to open Windows Movie Maker.
Write the steps to create a movie.
Write the steps to add filter to a movie.
Write the steps to add text/credit to a movie.

Answers to Worksheet
A. 1.
2.
3.
4.
5.
B. 1.
C. 1.
D.

Windows Movie Maker
imported
Storyboard
transition
titles, captions
True
2. False
(d)
2. (a)
Menu Bar

3. True
3. (b)

4. True
4. (e)

5. False
5. (c)

Tabs

Quick Access
Toolbar

Preview
Pane
Storyboard

E. 1. Following are the features of Windows Movie Maker.

• Easy to Use: It offers different file formats such as .WMY/, AFT, MPG (MPEG-1), .AVI (DV-AVI),
.WMA, .WAV and .MP3 which can be imported. Its files can be exported to many formats
like .MP$, .MP3, .MOV, .WMV and .AVI.

• Background Music: You can add background music to your videos with this software.
• Crop a Video: It is easy to edit a video with Windows Movie Maker. Crop and Zoom feature
helps to customise the screen of your video.

• Add Subtitles: Videos can be made clear and attractive with explanation of subtitles.
• Extracting Audio from Video: An important feature of this software is that the audio tracks
can be extracted from video tracks.

• Saving Projects Automatically: Movie Maker facilitates giving AutoSave option of projects
to avoid loss of data in case of unexpected situations.

• Availability of Online Library: The user can select and download appropriate audios
available at online music store of Movie Maker.

2. Follow these steps to open Windows Movie Maker.

• Click on the Start button.
• Scroll down the list and select Win Movie Maker. A ‘Win Movie Maker’ window opens.
3. Follow these steps to create a movie.

• Click on the Import Files option
• An ‘Import Media Files’ dialog box appears. Select the image or video. You can also select
multiple images using the Ctrl key.

• Click on the Open button.
• All images will appear on the storyboard. Click on the Play button on the ‘Preview Pane’ to

preview a movie.
4. Follow these steps to add filters to your movie.

•
•
•
•
•

Add videos and images to the timeline.

•
•
•
•
•
•
•
•
•

Add videos and images to timeline.

Click on the FILTERS option on the timeline.
Select the filter of your choice.
Click on Apply to Timeline to add the filter. You can also drag the filter to timeline.

Play the clip to observe the change.
5. Follow these steps to add text/credit to a movie.
Click on the TEXT/CREDIT option on the timeline.
Select the type of text and right-click on it.
Click on the Apply & Edit option.
A dialog box appears. Edit the default text and type something meaningful.
Now edit the title by selecting different font styles and colour schemes.
Click on the OK button.
Click on Apply to Timeline to add the text. You can also drag it to the timeline.
Play the clip to observe the change.

3. Introduction to Access
A. Fill in the blanks.
1. Software that creates and maintains a collection of databases is called __________________.
2. In a _________________ terminology, the row of a table is called tuple (record) and the
column is called attribute (field).
3. The questions that are based on the data given in a database are called ____________.
4. Microsoft Access is a part of a Microsoft ________________.
5. _______________________ is used to get help on any of the commands or topics related to
Access.
B. State whether the following statements are True or False.
1. Field property is applied to a particular field in a table and it defines the characteristics of that
field.
2. Secondary key is a key in a relational database that is unique for each record.
3. Table cannot be edited in Datasheet view and Design view.
4. Sorting a field in Access implies that you make the selected field/column appear on the
leftmost side in the table
5. Access provides a Ribbon to conveniently move through the records.
C. Match the columns.
		

Column A		

Column B

1. Title Bar

(a) Present at the top-left corner of the window

2. Quick Access Toolbar

(b) Present at the top of the window

3. Ribbon

(c) Place where you enter data

4. Navigation Pane

(d) Home, Create, External Data, Database Tools, Fields

5. Workspace

(e) Located on the left side of the Access window

D. Choose the correct answer.
1. Which of the following is used to access the required information from a database?
(a) Template			

(b) Queries

(c) DBMS			

(d) View

2. By default, a table is created in which of the following views?
(a) Datasheet view			

(b) Design view

(c) Primary view			

(d) Secondary view

3. Which of the following views allows you to enter names of the fields in the table and specify
their data types?
(a) Datasheet view			

(b) Design view

(c) Primary view			

(d) Secondary view

4. Which of the following is used to move through the records?

E.

(a) Ribbon			

(b) Title Bar

(c) Object Tab			

(d) Navigation Toolbar

Answer the following questions.
1. Write the steps to start Access 2016.
2. What are the parts of the Design view?
3. What is Datasheet view?
4. Can we switch between Datasheet view and Design View? If yes, write the steps to do the
same.
5. What are the ways in which we can create tables in Access?

Answers to Worksheet
A. 1.
2.
3.
4.
5.
B. 1.
C. 1.
D. 1.
E. 1.

Database Management System
relational database
queries
Office Suite
Tell me what you want to do
True
2. False
3. False
(b)
2. (a)
3. (d)
(b)
2. (a)
3. (b)
Follow these steps to start Access 2016.

4. False
4. (e)
4. (d)

5. False
5. (c)

• Click on the Start button.
• Scroll the list and click on Access 2016. Access window appears.
2. The Design view is divided into the following two parts.

• Field Grid Pane: Here, we define the Field Name, Data Type and Description.
• Field Properties Pane: Here, we set the properties for the fields of the table.
3. Datasheet View: Here, the table is displayed as a grid. Data can be entered directly into the
table’s rows and columns. Column indicates field and row indicates record.
4. Yes, we can switch between the Datasheet view and the Design view.
		 Follow these steps to switch between the views.

• Click on the Home tab.
• Click on the View option in the ‘Views’ group to switch between the Datasheet and Design

views.
5. Access 2016 allows you to create tables in the following two ways.
		 (i) Using Datasheet View: This view allows you to create a table just like a spreadsheet
that you commonly use in MS Excel. Data can be entered directly into the table’s rows
and columns. Although this is a simpler method, it is not a professional approach of
working with tables in a database.
		 (ii) Using Design View: This view allows you to create a table in a professional way by first
defining the structure of the table and then entering the data. This method is used by
programmers and professionals.

4. Working with Queries, Forms and Reports
A. Fill in the blanks.
1. A __________ is formed on topics and the result of a query is also placed in the form of a
table.
2. Query Window consists of ____________ and ______________.
3. Field, Table, Sort, Show, Criteria and Or are the components of the _____________.
4. There are three views to display a form: _____________, _____________ and _____________.
5. There are four views in which a report can be displayed: ___________, ___________,
___________ and ____________.
B. State whether the following statements are True or False.
1. Access holds multiple tables and table holds multiple records.
2. A query is just based on tables and other queries.
3. A query displays a set of records matching a certain criterion.
4. Relationship is built on a field of one table with the same field of another table.
5. A form looks very similar to a fill-in-the-blanks sheet that is filled by hand.
C. Match the columns.
		

Column A		

Column B

1. Field

(a) Filter the data in ascending or descending order

2. Table

(b) Displays the check box

3. Sort

(c) Criteria on which the records are to be filtered

4. Show

(d) Displays the name of the table

5. Criteria

(e) Displays the fields from the selected table

D. Complete the following statements.
1. A query is formed on topics and the result of a query is also placed in _______________________.
2. Once a relationship is built among the tables, the data from both the tables______________.
3. A query is based on tables, other queries or ______________________.
4. Access links a form to a table, so the entered information in a _____________________.
5. A form can be formatted using options available on the___________________________.
E.

Answer the following questions.
1. Write the steps to build a relationship among tables.
2. Write a not about the query window.
3. Write the steps to use a query.
4. Write the steps to specify multiple criteria.
5. Write a note about forms.

Answers to Worksheet
A. 1.
2.
3.
4.
5.
B. 1.
C. 1.
D. 1.
2.
3.
4.
5.
E. 1.

query
upper pane, bottom pane
Design grid
Form view, Design view, Layout view
Report view, Print view, Layout view, Design view
True
2. False
3. True
4. True
(e)
2. (d)
3. (a)
4. (b)
the form of a table
can be used by query or form
a combination of both
form is stored in a table
Design tab and Format tab
Follow these steps to build a relationship among tables.

•
•
•
•
•
•
•

5. True
5. (c)

Create two tables with a common field.
Open one table in ‘Datasheet’ view.
Click on the Database Tools tab.
Click on the Relationships button in the ‘Relationships’ group.
A ‘Show Table’ window appears displaying the list of tables present in the database.
Select the required table and click on the Add button.
A selected table gets added to the ‘Relationships’ window. In the similar way, add another
table to the ‘Relationships’ window.

• Click on the Close button to close ‘Show Table’ dialog box.
• Drag the primary key (Roll No) of the parent table (student) and drop it over the same field
in the child table (Result).

•
•
•
•

An ‘Edit Relationships’ dialog box appears. Click on the Create button.
A relationship will be built among the tables. You can see a line linking two tables.
Click on the Save button on ‘Quick Access Toolbar’ to save the relationship.

Click on the Close button in the ‘Relationships‘ group.
2. Query Window is divided into two panes: upper pane and bottom pane. The upper pane
displays the tables selected for the query. The bottom pane displays a design grid where
fields can be added to a query and a criteria can also be mentioned.
		 Let’s learn about the components of the Design grid.

• Field: It displays the fields from the selected table.
• Table: It displays the name of the table.
• Sort: It is used to filter the data either in ascending order or descending order.

• Show: It displays the check box, indicating the field that will be visible after the execution
of a query.

• Criteria: It specifies the criteria on which the records are to be filtered.
• Or: It is used to specify multiple criteria.
3. Follow these steps to use a query.

•
•
•
•
•
•
•

Select the table on which query will be generated. Here, we are selecting the ‘Result’ table.
Select the required field from the drop-down list of the ‘Field’ row in the ‘Design’ grid.
Select the order of sorting in the ‘Sort’ row.
Mention the criteria in the ‘Criteria’ row, i.e., ‘> 70’ under the ‘Marks’ column.
Click on the Run in the ‘Results’ group of the ‘Design’ tab.
The result of the query is displayed showing only those records that satisfy the criteria.
Click on the Close button of the ‘Query’ window to save the query. A dialog box appears
asking you to save changes to Query 1.

• Click on the Yes button to save the changes.
4. Follow these steps to specify multiple criteria.

• Select the table for the query, i.e., ‘Result’.
• Type two criteria on the same line, i.e., ‘> 50’ ‘Pass’.
• Here, only those records will be displayed whose both criteria will be met. It is called AND

condition.
5. A form looks very similar to a fill-in-the-blanks sheet that is filled by hand. A form can be
considered as a way to enter data into the database. Access links a form to a table, so the
entered information in a form is stored in a table. If a record in a form is changed, the applied
changes will reflect in the table also. There are three views to display a form: Form view,
Design view and Lodge view. Click on the View in the ‘Views’ group of the ‘Design’ tab to
switch between views.

• Form View: It is used to enter or edit data.
• Design View: It gives a detailed view of a form. In this view, a form is displayed in three
sections: Form header, Detail and Form footer.

• Layout View: It is used to change the form design, appearance and size of various controls.
		 The form is actually running when it is displayed in the Layout view.

5. Adobe Photoshop CS6
A. Fill in the blanks.
1.
2.
3.
4.
5.

_______________ is a graphic editing application software.
___________ allows to apply three different kinds of blurs and to create effects.
________________ is used to select a similar-coloured area of an image.
___________ displays the options related to the currently selected tool from the Tools Panel.
____________ displays all the layers in an image.

B. State whether the following statements are True or False.
1.
2.
3.
4.
5.

Swatches Panel displays the colour values for the current foreground and background colours.
Color Panel displays the most frequently used colours.
Styles Panel allows you to select, view and apply preset layer styles.
Marquee Selection Tool makes rectangular, elliptical, single row and single column selections.
Slice Select Tool trims the images.

C. Match the columns.
		
1.
2.
3.
4.
5.

Column A		
Menu Bar
(a)
Options Bar Control Panel
(b)
Workspace
(c)
Panels
(d)
Tools Panel
(e)

Column B
Place where one works
Located at the top of the window
Located below the Menu Bar
Left side of the Photoshop window
Right side of the Photoshop window

D. Label the components of Adobe Photoshop CS6 Window.

E.

Answer the following questions.
1.
2.
3.
4.
5.

What are the features of Photoshop CS6?
Write the steps to start Adobe Photoshop CS6.
Write the steps to create a new file.
Write the steps to save a file.
What is the Polygonal Lasso Tool? Write the steps to use the Polygonal Lasso Tool

Answers to Worksheet
A. 1.
2.
3.
4.
5.
B. 1.
C. 1.
D.

Adobe Photoshop
Blur Gallery		
Magic Wand Tool		
Options Bar Control Panel
Layers Panel
False
2. False
(b)
2. (c)

3. True
3. (a)

4. True
4. (e)

5. False
5. (d)
Title Bar

Menu Bar

Panels
Options Bar

Tools Panel

Workspace

E. 1. Following are some of the notable features of Photoshop CS6.

• Photoshop CS6 provides a revised new dark user-friendly interface.
• It performs photo editing in a lesser time.
• It creates graphics for web applications with reduced fi le size, which helps in fast loading
of websites.

• Photoshop CS6 adds support for Adobe Camera Raw 7.0, a plug-in for editing raw image
files.

•
•
•
•
•

New Video Timeline Panel allows to add effects to video clips.
It provides new character and paragraph styles that make type formatting much easier.
The Blur Gallery allows to apply three different kinds of blurs and to create effects.
Powerful Vector Tools allow the designer to design and shape graphic elements quickly.

It provides different brush styles to apply colours or patterns to the images.
2. Follow these steps to start Adobe Photoshop CS6.

• Click on the Start button.
• Scroll down the list and select Adobe Photoshop CS6. ‘Adobe Photoshop CS6’ window
appears.

3. Follow these steps to create a new file.

• Click on the File Menu.
• Select the New option. A ‘New’ dialog box appears.
• Enter the details like name of the file in the ‘Name’ textbox, set up the size of the file in
different forms of measurements like pixels and inches.

• Specify the resolution value in the ‘Resolution’ textbox. It specifies the clarity of an image.
Mention the colour in the ‘Color Mode’ textbox and provide the background of an image.

• Click on the OK button.
4. Follow these steps to save a file.

•
•
•
•

Click on the File menu.
Select the Save As option. The ‘Save As’ dialog box appears.
Select the location and specify name of the file in the ‘File name’ box.

Click on the Save button.
5. Polygonal Lasso Tool is also used to make freehand selections. But the selection using this
tool is done by clicking at a point and clicking at the next end points of the segment until the
entire object is selected.
		 Follow these steps to use the Polygonal Lasso Tool.

• Right-click on the Lasso Tool on the ‘Tools Panel’.
• Select the Polygonal Lasso Tool from the list.
• Click on the image at any point. Hold down the left mouse button. Click at the next place

where you want the first line to end. Keep clicking till the entire object is selected. You will
observe the selected part in a dashed form.

6. More on Photoshop CS6
A. Fill in the blanks.
1. __________________ provides several tools for painting and editing image colours.
2. ___________ and ___________ work like traditional drawing tools applying colour with
brush strokes.
3. ______________ allows to paint in a more realistic way by mixing different colours on the
canvas, combining colours on a brush and varying paint wetness across a stock.
4. ___________ is used to fill an area with a range of colours.
5. _______________ help to patch and heal tears, scratches and even red eyes.
B. State whether the following statements are True or False.
1.
2.
3.
4.

Clone Stamp Tool is used to copy one area of an image onto another area of the image.
Pencil Tool is used to draw different shapes like rectangle and polygon.
Gradient Tool is used for repairing imperfections.
Mixer Tool replaces the existing colour of an image with a foreground colour without painting
over the image.
5. Blur Tool is used to soften an image. It basically unfocusses the image area.
C. Match the columns.
		Column A		
1. Mixer Brush Too

(a)

2. Color Replacement Tool

(b)

3. Clone Stamp Tool

(c)

4. Spot Healing Brush Tool

(d)

5. Content Aware Move Tool

(e)

Column B

D. Name the tools to perform the following tasks.
1.
2.
3.
4.
5.
E.

Freehand drawings			
Replace the existing colour of an image with a foreground colour
Paint in a more realistic way			
Repair imperfections			
Replace unwanted parts from an image			

___________________
___________________
___________________
___________________
___________________

Answer the following questions.
1.
2.
3.
4.
5.

Write the steps to delete a layer.
Write a short note on hiding and moving a layer.
What do you understand by working with layers? How does it help?
What is the use of the Patch Too? Write the steps for using the Patch Tool.
Write a note on the Gradient Tool. Also, write the steps to use the tool.

Answers to Worksheet
A. 1.
3.
B. 1.
C. 1.
D. 1.
3.
E. 1.

Adobe Photoshop		
2.
Mixer Brush Tool			
4.
True
2. False
3.
(b)
2. (d)
3.
Pencil Tool			
2.
Mixer Brush Tool			
4.
Follow these steps to delete a layer.

Brush Tool, Pencil Tool
Gradient Tool	      5.
False
4. False
(e)
4. (a)
Color Replacement Tool
Spot Healing Brush Tool

Retouching Tools
5. True
5. (c)
5. Patch Tool

• Select the layer from ‘Layer Palette’.
• Click on the Layer menu. Select the Delete → Layer option.
2. You can hide a layer to make its elements invisible from the image. To hide a layer, click on the
Indicate Layer Visibility button before the layer name in the ‘Layer Palette’.
		 You can also move the layer to some other location in the image. To move a layer, select the
layer from the ‘Layer Palette’ and click on the Move Tool from the ‘Tool Palette’. Now, click and
drag the layer inside the workspace.
3. A Photoshop image consists of multiple layers, where each layer has different elements.
Layers are the transparent sheets that hold objects. Layers help in the following ways.
• You can draw objects on one layer without affecting the objects of another layer.
• You can add a number of layers, hide and lock them.
• Layers can be combined, hidden and duplicated.
4. Patch Tool is used when you want to replace some unwanted parts from an image and replace
them with matching parts from the nearby area. For example, this tool can be used to replace
a dark spot with the skin colour of your face.
		 Follow these steps to use the Patch Tool.

•
•
•
•

Open the desired image.
Right-click on the Spot Healing Brush Tool on the ‘Tools Panel’ and select the Patch Tool.
Select a part of the image to be replaced by dragging a line around it with the Patch Tool.

Now, drag the selected area over the area from which it needs to be replaced.
5. Gradient Tool is used to fill an area with a range of colours. It creates a gradual blend between
multiple colours. You can choose from preset gradient fills or create your own.
		 Follow these steps to use the Gradient Tool.
• Open an image.
• Right-click on the Lasso Tool and select the Polygonal Lasso Tool. Using the Polygonal
Lasso Tool, select a part of the image.
• Click on the Gradient Tool from the ‘Tools Panel’.
• Right-click on the Gradient Picker on the ‘Options Bar’. A ‘Gradient Editor’ dialog box
appears. You can select from the ‘Presets’ given or you can perform the required changes
and click on the OK button.
• Select the Linear Gradient on the ‘Options Bar’. Click and drag the mouse pointer in the
selected area. The gradient gets applied.

7. Visual Studio Community 2017
A. Fill in the blanks.
1. A ________________ is a special language used by the programmers to communicate with a
computer.
2. Any action like pressing a key or clicking a mouse performed in Visual Basic is called an
_________.
3. _______________ is a part of Microsoft Visual Studio Community 2017 package.
4. Visual Basic program has three modes: ____________, ____________ and ____________.
5. __________ displays the descriptive text of a control.
B. State whether the following statements are True or False.
1. Label gets the input from the user. We are allowed to enter text and numbers in it.
2. Button is used to create an event.
3. Operators never form an expression when applied to variables and constants.
4. Arithmetic operators are used to perform various arithmetic calculations.
5. Logical operators are used to compare the values of two variables.
C. Identify the different components of the given window.

D. Answer the following questions.
1. What are the modes in a Visual Basic program?
2. Write the steps to start Visual Basic 2017.
3. Write the steps to create a new project.
4. Write the steps to add control to the form.
5. Write the steps to set the properties of a control.

Answers to Worksheet
A. 1. programming language   2. event
4. Design mode, Run mode, Break mode		
B. 1. False
2. True
3. False
C.
Title bar

3. Visual Basic 2017
5. Label
4. True
5. False

Menu
bar
Toolbar
Code
Window

Solution
Explorer
Form
Window
Toolbox

Properties
window

D. 1. A Visual Basic program has three modes.
• Design Mode: This mode is used to write the statements for a program. Here, the
programmer plays a vital role.
• Run Mode: This mode is used to execute the statements written by a programmer. Here,
the result is shown for which it has been designed.
• Break Mode: This mode appears when the application you are trying to run contains errors.
Here, the execution is paused and the user is warned to remove the errors.
2. Follow these steps to start Visual Basic 2017.
• Click on the Start button.
• Scroll down the list and select Visual Studio 2017. The ‘Visual Studio 2017’ screen appears.
3. Follow these steps to create a new project.
• Click on the Create new project option in the ‘Start Page’. A ‘New Project’ window appears.
• Select the Visual Basic button on the left pane and select the Windows Forms App (.NET
Framework).
• Click on the OK button.
4. Follow these steps to add control to the form.
• Select the desired control from the ‘Toolbox’ by clicking on it.
• Move the mouse pointer to the ‘Form’ window and drag it to draw the selected control. The
size and shape for the control can be changed as per the requirement.
5. Follow these steps to set the properties of a control.
• Select the control whose property needs to be set.
• Properties related to the control appear on the ‘Properties’ window. Click on the desired
property.
• Reset the property and changes in the control will be observed.

8. More on Visual Studio 2017
A. Fill in the blanks.
1. ____________ is a control used to display the images. _________ is a control used to display
a list of items.
2. There are three types of loops in Visual Basic 2017: ____________, ______________ and
________________ loop.
3. ___________ is a control used to present a list of various items.
4. ____________ allows the user to check only one option out of the number of choices
displayed.
5. ____________ is the transfer of control of execution to a different part of program.
B. State whether the following statements are True or False.
1. When you add a PictureBox to your form, it displays a rectangular boundary.
2. In ListBox, items can be added and removed at the design time and also at the runtime.
3. The user clicks on the handle on the right of the ComboBox to see the items which are present
in the drop-down list.
4. RadioButton is also known as Option Button.
5. If....Then....Else statement does not provide alternative output for the user.
C. Complete the sentence.
1. For.…Next loop repeats a set of statements, ______________________________________.
2. Do....While loop repeats a set of statements till ____________________________________.
3. While….End While loop executes a set of statements till the specified condition __________
_____________________.
4. Control statements are divided into two categories: ________________________________.
5. RadioButton allows the user to check only one option out of the_______________________
_____________________.
D. Answer the following questions.
1. Write the steps to insert a picture in a form.
2. Write the steps to add an item to a ListBox at the design time.
3. Write the steps to add an item to a ComboBox.
4. Write a note on looping.

Answers to Worksheet
A. 1.
2.
3.
4.
5.
B. 1.
4.
C. 1.
2.
3.
4.
5.
D. 1.

PictureBox, ListBox
For….Next loop, Do….While loop, While….End While
ComboBox
RadioButton
Branching
True
2. True
3. True
True
5. False
a fixed number of times
the specified condition remains true
evaluates to be true
branching and looping
number of choices displayed
Follow these steps to insert a picture in a form.

•
•
•
•

Click on the PictureBox control in the ‘Toolbox’.
Move the mouse pointer to a form. Click and drag to draw a PictureBox on

the form.

Set the size of PictureBox by changing the value of size in the ‘Properties’ box.
Now sets the border property to ‘FixedSingle’ and its background colour to ‘White’ in the
‘Properties’ box.

• Right-click on the PictureBox to bring out its properties window. In the ‘Properties’ window,
scroll to the Image property.

•
•
•
•
•

Click on the grey button on its right side. ‘Select Resource’ dialog box appears.
Select ‘Local resource’ and click on the Import button. An ‘Open’ dialog box appears.
Select the desired image of your choice from the set location.
Click on the Open button.

Click on the OK button. The selected image will be displayed in the ‘PictureBox’.
2. Follow these steps to add an item to a ListBox at the design time.

• Click on the ListBox control in the ‘Toolbox’.
• Move the mouse pointer to a form. Click and drag the mouse pointer to draw a ListBox on
a form.

• Right-click on the ListBox to access the ‘Properties’ window.
• Click on the collection of Items property.
• A ‘String Collection Editor’ dialog box will be displayed. Enter the items one by one by
typing the text and press the Enter key to enter the next item.

• Click on the OK button. The item will be displayed in the ListBox.
3. Follow these steps to add an item to a ComboBox.
• Click on the ComboBox control in the ‘Toolbox’.

• Move the mouse pointer to a form. Click and drag the mouse pointer to draw a ComboBox
on the form.

• Right-click on the ComboBox to access the ‘Properties’ window.
• Click on the collection of Items property.
• A String Collection Editor dialog box will be displayed. Enter the items one by one by
typing the text and press the Enter key to enter next item.

• Click on the OK button. The items will be displayed in the ‘ComboBox’.
4. Looping refers to a process that runs repeatedly until a certain condition is met. For example,
we can design a program that adds a series of numbers until the sum exceeds a certain value
or a program that asks the user to enter data repeatedly until he or she enters the word
‘Finish’. There are three types of loops in Visual Basic 2017, namely the For....Next loop, the
Do....While loop, and the While....End While loop.

9. Creating Lists and Tables in HTML5
A. Fill in the blanks.
1. HTML _________ are the way for presenting information in a well formed and systematic
manner.
2. ____________ property helps to set the layout of a table.
3. ____________ property is used for placement of a table caption.
4. _______________ property of table specifies whether border and background are to be
placed around empty cells in a table or not.
5. _____________________ property helps to set the height and width of the table.
B. State whether the following statements are True or False.
1. List presents the information in a haphazard form.
2. Collapse property is used to collapse (merge) into border or detached as usual.
3. A table is an intersection of row and column.
4. Title of the table which provides brief description of table is called data.
5. A cell is a collection of information in form of record consisting of rows and columns.
C. Write the tags for the following.
1. Tag that defines description list
2. Tag that defines ordered list
3. Tag for each item in an ordered list
4. Tag that defines unordered list
5. Tag that defines table
D. Explain the following.
1. Ordered List
2. Unordered List
3. Description List
E.

Answer the following questions.
1. Name the types of lists available in HTML.
2. What is a nested list?
3. Write notes on border spacing and border collapse.

Answers to Worksheet
A. 1.
4.
B. 1.
C. 1.
D. 1.

2.

3.
E. 1.
		
		
		
2.
		

3.
		
		
		
		
		
		
		

lists			
2. Table-layout			
3. Caption-side
Empty cells			
5. Height and width
False
2. True
3. False
4. False
5. False
<dl>
2. <ol>
3. <li>
4. <ul>
5. <table>
An ordered list is a number or alphabetic list of items. It gives ability to control the sequence
of numbers or start from a particular number. An ordered list starts with <ol> tag. Each list
item starts with <li> tag. The list items are marked with number by default. For example,
while displaying the result of students, if the ranking of students are not numbered orderly,
the result will be of no use.
An unordered list in HTML is a list of related items which can be displayed in any order as
their order does not matter. An unordered list can be created in HTML using tag <ul>. Each
element within an unordered list is individually marked up using list item element <li>. A list
of colours is an example.
Another type of list is description list. This is a list of terms with a description of each term. It
is also called definition list which displays elements in definition form like in dictionary.
Following are the three types of lists available in HTML.
(i) Ordered list
(ii)		Unordered list
(iii) Description list
When a list occurs as an element of another list, it is known as nested list.
For example:

Border spacing property helps to specify distance between the borders of the adjacent cells.
Syntax: border-spacing: value
Where value = Horizontal spacing in px Vertical spacing in px
Example: border-spacing: 10 px (both horizontal and vertical spacing is 10 px) borderspacing: 10 px 20 px (horizontal spacing is 10 px, vertical spacing is 20 px)
Border-Collapse: Collapse property is used to collapse (merge) into border or detached as
usual.
Syntax: border-collapse : Value
Where value = Separate/collapse
Example: border-collapse : Separate

10. Images, Links and Frames in HTML5
A. Fill in the blanks.
1. ______ , _______ and ______ formats of images are supported formats of HTML.
2. Two types of images can be displayed on web pages: __________ images and __________
images.
3. A ___________ is a collection of web pages.
4. HTML links are also called __________.
5. Web pages can be linked as __________ using CSS styling. This can be done by using anchor
tag ____ and _____ attribute.
B. State whether the following statements are True or False.
1. Hyperlinking cannot be done for an image.
2. The href attribute specifies the destination of link.
3. Web pages cannot be linked using images to other documents.
4. Most of the browsers support the <audio> tag in HTML5.
5. Before using <video> tag, a plugin may be installed (like flash).
C. Write the tags for the following.
1. Tag to add frames in HTML
2. Tag to add video to our web page
3. Tag to insert a image in an HTML web page.
4. Tag to insert a audio in a web page.
D. Answer the following questions.
1. What are the types of images that can be displayed on web pages?
2. Write a note on the linking of web pages.
3. Write a few lines about frames.

Answers to Worksheet
A. 1.
2.
3.
4.
5.
B. 1.
C. 1.
2.
3.
4.
D. 1.

JPEG, PNG, GIF
inline, external
website
hyperlinks
buttons, <a>, href
False
2. True
3. False
4. True
5. True
Frames can be added in HTML using <iframe> tag.
We can add video to our web page with <video> tag.
The <img> tag is used to insert a image in an HTML web page.
<audio> tag specifies a standard way to insert a audio in a web page.
There are two types of images that can be displayed on web pages: inline images and external
images.

• Inline Images: These images are displayed as soon as web pages are accessed. To insert
inline images, <img> tag is used.

• External Images: These images are referenced and displayed separately by clicking on a
2.

		
		
		

link. They are not displayed automatically. The images are inserted using anchor tag <a>
to establish a link to image.
A website is a collection of web pages. Two or more web pages are linked together in a
website. HTML links are also called hyperlinks. When we move mouse over a link, the mouse
arrow will turn into little hand which represents a hyperlink. Hyperlinking can be done for an
image also. In HTML, links are defined with the <a> tag.
Syntax: <a href = “value”> click here </a>
The href attribute specifies the destination of link. Clicking on the link text will send you to
the specified address.
Link Colors: Following link colours appear by default on hyperlinks.

• An active link is underlined and coloured red.
• An unvisited link is underlined and coloured blue.
• A visited link is underlined and coloured purple.
3. Frames are the ways to organise HTML web pages of the website. Till now we are displaying
one document on the entire window of the browser but with the help of the frames we
can display more than one document on the window. With the help of frames, multiple
HTML documents may be presented on independent window. Frames make the web page
attractive by displaying different content on a web page like logo, banner and image.

11. Internet Apps
A. Fill in the blanks.
1. Plug-ins like ______________, ____________ and ___________ are required to play streaming
audio and video files.
2. _________ and ____________ are plug-ins that display the creation and implementation of
the entire multimedia display with audio, animation and graphics.
3. Audio and video files can now be easily _____________ or ____________ into a computer.
4. Today many companies are selling their products online. This process is called ___________.
5. A ________________ app is a medium where a person can get connected to other people
online.
B. State whether the following statements are True or False.
1. The Internet is a worldwide network of computer networks.
2. Multimedia refers to computer information that can be represented through audio.
3. There are millions of websites that provide the Internet users with an opportunity to create
their own blogs.
4. Voice-over-Internet Protocol is a methodology for the delivery of voice communications and
multimedia sessions over Internet
5. Plug-in is a program that can easily be installed and used as part of your web browser.
C. Match the columns.
		

Column A		

Column B

1. Business Automation App

(a)

2. Ecommerce Web App

(b) Facebook

3. Real-time Communication App

(c)

4. Social Networking App

(d) Blue prism

5. Blogging Site

(e)

D. Explain the following.
1. Business Automation Apps
2. Ecommerce Web Apps
3. Real-time Communication
4. Skype
5. Social Networking Apps

Skype
www.blog.twitter.com
Amazon
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2.

3.

4.

5.

Windows Media Player, QuickTime, RealPlayer
Flash, Shockwave
downloaded, streamed
e-commerce
social networking
True
2. True
3. True
4. True
5. True
(d)
2. (e)
3. (a)
4. (b)
5. (c)
Many companies use and implement different web app solutions that offer significant
changes to the entire workflow. Some examples of such apps are UiPath, Blue prism and
Automation Anywhere.
Today may companies and organisations are promoting and selling their products online.
This process is called e-commerce. These companies use their Internet apps and through
these apps they are able to reach millions of people. The people or the customers can easily
choose any product and place their order each time. These apps also provide easy e-payment
methods. Apps of Amazon, Flipkart and eBay are some examples of e-commerce applications.
Many apps are available on the Internet for communication. Most popular communication
applications are the apps where live communication can be done. This type of communication
is called real-time communication. Real-time communication allows audio, video and text
communication to take place in real-time online.
Skype is a free software program that allows you to make video and audio calls peer-topeer or in groups. Though it is now owned by Microsoft, it was first released in 2003 and
was created by Niklas Zennström and Janus Friis. With Skype, you can send instant messages
and share files with friends, family, co-workers, and anyone else you would like to converse
from any part of the world. As long as you have an Internet connection, you can use Skype
to chat with one or more people face-to-face. Skype is a communication tool. Most of its
services are free of cost. However, some value added services are chargeable as per the user’s
requirement.
A social networking app is a medium where a person can get connected to other people
online. The person may have similar personal or career interests. Social networking apps help
people to connect to friends, family, classmates, customers and clients. These applications
are used on personal level or for business purposes or for both. They are also called Web 2.0
applications or social apps. Most popular social networking media apps are as follows.

•
•
•
•
•

Facebook
Twitter
WhatsApp
Instagram
Google +

